Chapter 1

Getting to Know Autodesk® 3ds Max® 2013

Welcome to Mastering Autodesk 3ds Max 2013. Autodesk 3ds Max is the premier software package for 3D modeling, texturing, and animation, and it has many features specifically designed to assist artists, architects, engineers, and designers in various disciplines in the realization of their projects. It includes a Software Development Kit (SDK), which is used to develop plug-ins that give the program additional functionality. 3ds Max Design is a different installation and, in addition to having all the features of 3ds Max (except for the SDK), 3ds Max Design offers two exclusive tools. The Lighting Analysis tool is used to help meet the Leadership in Energy and Environmental Design (LEED) 8.1 certification standards. The Civil Visualization Extension is a customized version of the Dynamite VSP plug-in for importing design data from AutoCAD Civil 3D or the Bentley MX design tools. In this book, we simply refer to the program as 3ds Max.

Autodesk 3ds Max 2013 provides users with cutting-edge rendering technology, easy-to-use materials, improved interoperability with other related design and CAD software, enhancements to modeling and animation tools, and better viewport interactivity than ever before.

This chapter introduces some of the special features of 3ds Max 2013, and then it gets you started working with the 3ds Max interface.

In this chapter, you will learn to

- Navigate and configure the viewports
- Dock and float toolbars
- Copy objects and use the transform tools
- Create a named selection set

Introducing the New 3ds Max 2013 Features

3ds Max 2013 is a notable release that extends the comprehensive features and functionality with new, exciting capabilities, and it also updates many existing features. This is an important release with a long list of improvements and additions that will greatly impact your projects, whether you have been using 3ds Max for a number of years or are new to the world of 3D.

Each new version of 3ds Max incorporates fresh and exciting tools to enhance your capabilities and workflow while also increasing the performance of the program on your computer system. Utilizing these new features is a key to improving your skills and decreasing the time
it takes to complete your projects. When you start the program, you are presented with the Welcome To 3ds Max dialog box (see Figure 1.1), which includes links to Essential Skills Movies, which teach many of the basic skills for using 3ds Max. It also includes a link to the “What’s New” section of the Help documents, which explain the new features and links to the 3ds Max Learning Channel on YouTube. Autodesk has done a tremendous job of regularly adding new content to that channel. The Welcome To 3ds Max dialog box also provides you quick access to start a new empty scene, the Open File dialog box, and a list of the last 10 files you have opened. Note that if you don’t see this dialog box, you can go to the Help menu and click Essential Skills Movies from there.

**Figure 1.1**
The Welcome To 3ds Max dialog box

Here, in no particular order, are some of the high points of 3ds Max 2013:

**Modeless Array Dialog Box**  The Array dialog box is now modeless, meaning that you can interact with the 3ds Max 2013 viewports while the dialog box is open, so that you can adjust your views and see the preview of the array before you commit to it. This is a great ease-of-use update for 3ds Max.

**Egg Spline**  A new default shape called *Egg* has been added to 3ds Max. This allows you to create a closed spline that resembles an egg. The spline shape includes a built-in Outline parameter. This feature is in both 3ds Max 2013 and 3ds Max Design 2013, and it is primarily used for support of the Autodesk Civil View Pipe Network tools that work only with 3ds Max Design 2013.

**Hair And Fur**  Hair And Fur has seen some updates for 3ds Max 2013.

**MassFX**  The MassFX dynamics tools from NVIDIA have been updated and now include cloth simulation, an updated Ragdoll (formerly Skeleton) system, and a Multi-Object Editor to modify selections of objects more easily. Dynamics simulations can now take advantage of and interact with standard 3ds Max Force space warps.
gPoly  gPoly is a new mesh format designed and optimized for the internal mesh format of 3ds Max, which eliminates the conversions needed from editable mesh and poly formats. The result is faster animation when playing back high-resolution deforming objects.

Retime Tool  The new Retime Tool works in the Curve Editor to help you adjust the animation of your scenes.

Track View  The Track View menus have been updated to more closely resemble the animation editor found in Autodesk® Maya® software.

Autodesk Animation Store  The Autodesk Animation Store appears at the bottom of the Animation menu, and it opens in the Utilities tab. You can browse a selection of readymade animation clips, purchase the animation clips directly from the site, and apply them to your Biped-based characters.

Skin Modifier  The Skin Modifier has been updated to sort bones automatically in ascending or descending order and provide better content filtering of bone names based on user-entered criteria.

Workspaces  3ds Max 2013 users can now store multiple workspaces directly in a 3ds Max 2013 session. The workspaces are accessed from the Quick Access toolbar at the top of the 3ds Max interface.

State Sets  Found on the Rendering menu, state sets provide you with a way to keep and interact with different states of scenes you are editing. State sets also directly integrate with Adobe After Effects CS4 (32-bit) and CS5.x (64-bit only) so that you can send your 3ds Max 2013 scene to After Effects, make modifications, and then have those updates applied back to 3ds Max.

Viewport Layouts  The Viewport Layouts toolbar appears on the 3ds Max 2013 interface vertically along the left edge, and it allows you to store and quickly access different viewport configurations set up in the scene.

Skylights  Skylights in 3ds Max 2013 have been updated with Sky Color Maps that can use HDR images, which can then be used to render illumination in all renderers and also cast light and shadows in the Nitrous viewports.

Viewport Gradient Background  The Nitrous viewports now use a default gradient as the background of Perspective viewports. You will see this in the screen captures throughout this book. The gradient colors can be changed in the Customize User Interface dialog box.

Nitrous Viewports  The Nitrous viewports have been improved. The Perspective viewport now has a gradient background that you can customize; performance on large scenes has been improved; support for image-based lighting using the Skylight enhancements, viewport depth of field, and new Facets and Clay shading modes have been added.

Slate Material Editor  The interface for the Slate Material Editor has been improved. The nodes that are displayed in the Parameter Editor now have a dotted line surrounding them in the View windows; context menus work with multiple items selected. You can now get the materials from a selected object brought to the active View window, using the Get From Selected feature of the Material menu. There are new options that make working with material libraries much easier.
Render Setup Dialog  The Render Setup dialog has been improved with a drop-down menu that allows you to quickly select among Production, Iterative, ActiveShade, and Network Rendering.

IRay Renderer  The NVIDIA iray renderer for 3ds Max 2013 has been upgraded to iray 2.1.

Mental Ray Renderer  The NVIDIA mental ray rendering engine has been updated to mental ray 3.10.

FBX File Link Enhancements  The File Link Manager is now capable of directly linking Revit Architecture (RVT) files, and new Link options can be found by going to Application menu > Import.

Improved Geometry Support  3ds Max 2013 takes advantage of Autodesk DirectConnect to support importing many different data formats into 3ds Max 2013 as Body objects, including STEP files, SolidWorks, Pro/E, CATIA (v4 and v5), and IGES files (which no longer come in as NURBS objects).

Send To Menu  The new Send To feature on the Application menu allows you to send files directly to Maya, Autodesk® Softimage®, Autodesk® MotionBuilder®, Autodesk® Mudbox®, and Autodesk® Infrastructure Modeler software if you are running one of the Autodesk suites.

Maya Interaction Mode  For 3ds Max 2013 users who are accustomed to using Autodesk Maya, the new Maya Interaction mode adjusts 3ds Max 2013 to work with viewport controls and keyboard shortcuts from Maya.

Lightscape Compatibility Removed  If you are a previous user of 3ds Max, 3ds Max Design, or 3ds VIZ and Lightscape, be aware that all Lightscape compatibility, utility, and material features have been removed from 3ds Max 2013.

Product Updates  3ds Max 2013 also ushers in a new update scheme. Instead of having confusingly numbered Hot Fixes and service packs that you have to make sure to install in the correct order for 3ds Max to function properly, fixes for 3ds Max will now come out as sequentially numbered Product Updates. These Product Updates are easy to install in the right order and will ensure that 3ds Max is working properly. Make sure that your installation of 3ds Max 2013 has all available Product Updates installed before proceeding with the exercises in this book.

For more information about the new features and improvements in 3ds Max, go to the “What’s New in Autodesk 3ds Max 2013” section of the Help system. You can also find information on the Autodesk website or the Autodesk media and entertainment forums called the Area (area.autodesk.com).

Getting Started with Autodesk 3ds Max

Although many of 3ds Max’s components are typical for a Windows program, quite a few are unique to 3ds Max; therefore, a solid understanding of them is essential to using the program effectively. To begin exploring the 3ds Max 2013 interface, start the program by doing one of the following:

◆ Double-click the 3ds Max 2013 icon on the Desktop.
◆ Choose Start ➤ All Programs ➤ Autodesk ➤ Autodesk 3ds Max 2013 ➤ Autodesk 3ds Max 2013.

If you are on a 64-bit Windows system, you will see the 64-bit suffix on the folder and icon names.

You’ll see a variety of components in the 3ds Max 2013 window (see Figure 1.2). Some may be familiar to you while others may not.

**Figure 1.2**
The standard 3ds Max 2013 window

---

**THE LARGE ICONS OPTION**

The images in this book use the default Large Icons option to display the toolbar buttons better. To deactivate this option and use the smaller icons, thereby gaining some much-needed viewport workspace, choose Customize ➤ Preferences to open the Preference Settings dialog box. In the UI Display group of the General tab, deselect the Use Large Toolbar Buttons option, and then shut down and restart 3ds Max for this setting to take effect.

At the top, you see a typical Windows menu bar and the 3ds Max Main Toolbar. Depending on your default settings, you may also see up to nine more floating or docked toolbars containing additional 3ds Max tools. Beneath the Main Toolbar is the Graphite Modeling Tools toolbar. In the center, you see the viewport area, which currently shows the Top, Front, Left, and Perspective viewports. At the lower-right corner of the screen, you find the viewport navigation tools for adjusting your views in the current viewport. Also included are the time controls for creating and playing animations, the prompt line and status bar, and the MAXScript Mini Listener (for creating macros). On the left side of the window above the MAXScript area is the new Viewport Layout Tabs toolbar. On the right side of the user interface is the Command panel, which contains nearly all the tools you’ll use to create and edit objects in 3ds Max. Let’s take a closer look at each of these components. 3ds Max often provides several methods, including toolbars, Command panels, menus, and shortcuts, for accomplishing the same task.
Touring the Interface

3ds Max offers a wealth of tools, and their sheer number can be overwhelming. To get a basic understanding of the 3ds Max window, we’ll present each of the window components individually, starting with the Menu Bar.

The Menu Bar

At the top of the screen is the Menu Bar. Here you’ll find the typical Windows commands for file maintenance, as well as commands specific to 3ds Max.

Standard to 3ds Max 2013 is the Application button (see Figure 1.3), which replaced the traditional File menu in the 2010 release. The Application button is a graphical representation of the tools from the traditional File menu, including opening and saving files, importing, exporting, and referencing files. The Application button is also where you can set a project folder, access the Asset Tracking tool, and check statistics about the current file. If you are more comfortable using the traditional File menu, you can restore it to the 3ds Max interface using the dialog box that appears when you select Customize > Customize User Interface.

**Figure 1.3**
The Application button

The options in the Menu Bar are organized the same way as they are in most Windows applications. Clicking an option issues a command, and you’re expected to take some action. An option that’s followed by three periods, called an *ellipsis*, opens a dialog box, usually to allow you to make changes to settings related to the option. An option with a right-pointing arrow displays more options in what is called a *cascading menu*, as shown in Figure 1.4. Depending on your version of Windows, user settings, and if you have a pen tablet attached to you system, your menus may cascade to the left or to the right.

**Figure 1.4**
A typical cascading menu
Try out the Menu Bar by taking a look at the Units Setup dialog box:

1. Choose Customize ➤ Units Setup. The Units Setup dialog box displays.

2. Select the US Standard radio button, and make sure that Feet w/Decimal Inches is selected below it and that the Inches radio button is selected for Default Units, as shown in Figure 1.5.

![Figure 1.5](image)

Defining the units in the Units Setup dialog box

3. Click the System Unit Setup button at the top of the dialog box, and you will see the System Unit Setup dialog box shown in Figure 1.6. Make sure 1 Unit is set to 1.0 Inches. Do not change anything else in the System Unit Setup dialog box, and click OK twice to close both dialog boxes.

![Figure 1.6](image)

The System Unit Setup dialog box

By setting the System Unit Setup options, you ensure that you’ll be working with the same units that are discussed in this book.
**Reverting to the Startup Layout**

3ds Max 2013 is something of a chameleon. It can change its appearance depending on the focus of your modeling needs. Users of 3ds Max 2013 will see tools designed more for the game and entertainment industries, while users of 3ds Max Design 2013 will see an interface and defaults geared more toward architectural and design visualization. If your 3ds Max 2013 window doesn’t look the way it does in the figures in this book, choose Customize > Revert To Startup Layout. You’ll see a warning message telling you that any user interface (UI) changes you have made will be lost. Click Yes to set up your 3ds Max windows to match the interface you see in this book. You can also reload Custom UI schemes to reset the interface or use the Custom UI and Defaults Switcher to accomplish the same thing, plus more. See the “Working with the Custom UI And Defaults Switcher” section later in this chapter for more information on this topic.

**The Quick Access Toolbar**

Just to the right of the Application button is the Quick Access Toolbar, shown in Figure 1.7, another standard feature in 3ds Max 2013. As its name implies, it provides quick access to a number of useful commands, including New Scene, Open File, Save File, Undo and Redo Scene Operation, the Select Project Folder Browser, and the Workspaces tool.

**Figure 1.7**
The Quick Access Toolbar

Click the Undo Scene Operation button to undo your last actions, up to 20 by default, or the Redo Scene Operation button to redo any undone actions. Clicking the drop-down button next to either the Undo or Redo Scene Operation button opens a list of actions from which you can select.

You can customize the Quick Access Toolbar by clicking the down-arrow icon at the far right of the toolbar.

**The Information Center Toolbar**

All the way across the screen at the upper-right corner of the interface, near the traditional Windows Minimize, Maximize, and Close buttons, is the Information Center Toolbar, as shown in Figure 1.8. The Information Center Toolbar provides a search function for 3ds Max topics in the online Help files and on the Autodesk website; the Subscription Center (if you have Subscription Center access); the Communication Center, where you’ll receive notices of program updates and other relevant announcements; a Favorites panel, where you can store links to commonly-accessed websites; and pages and elements from the 3ds Max Help menu. You can use the right-facing arrow button at the left end of the Information Center Toolbar to minimize the Search field if you wish.

**Figure 1.8**
The upper-right corner of the 3ds Max 2013 interface
The Main Toolbar

Just below the Menu Bar is the Main Toolbar. The tools on this toolbar offer tooltips, which are exposed when your cursor pauses over them, to help you identify their purpose.

The first set of tools, shown in Figure 1.9, is for linking and selecting objects. The two linking tools, one for linking and the other for unlinking, cause one object to move, rotate, or scale based on commands applied to another object. The third linking tool, the Bind To Space Warp tool, can be used to attach objects and space warps to each other. The selection filter allows you to limit what can be selected with the cursor. The selection tools let you select objects by clicking them or by selecting them by name. You can also specify the method for selecting objects by using a selection window, which lets you indicate a selection by placing a rectangle, circle, or other border around the objects.

**Figure 1.9**
The Linking and Selecting tools on the 3ds Max 2013 Main Toolbar

To the right of the selection tools are the transform tools, shown in Figure 1.10. This set of tools lets you select and move, rotate, and scale objects. You can also choose the reference coordinate system; set the center of the transform using the pivot point options; toggle the ability to manipulate certain objects, modifiers, and controllers by clicking and dragging visible manipulators in the viewports; toggle the keyboard shortcut overrides; use different snap options; work with named selection sets; and use tools to mirror and align objects.

**Figure 1.10**
The 3ds Max transform tools

The next group of tools to the right, shown in Figure 1.11, includes access to the Layer Manager, the Graphite Modeling Tools display toggle, the Track View Curve Editor, the Schematic View tools, and the Material Editors and rendering tools. The Layer Manager gives you control over all of the settings for layers in your scene and the objects contained in those layers. The Graphite Modeling Tools are a complete set of more than 100 tools to improve creating and editing poly objects within 3ds Max. (Note that the Graphite Modeling Tools are the first 3ds Max tools available on a customizable ribbon interface. You will explore the Graphite Modeling Tools interface in Chapter 4, “Editing Meshes and Creating Complex Objects.”) The Track View - Curve Editor displays your scene information as curves on a graph that indicates the position, rotation, and scale of objects in your scenes over time. Dope Sheet mode displays a graph of the keys of your animation over time. The Schematic View tools provide a visual graph and control how all the elements of your scene are linked. The Materials tools give you control over the appearance of objects by defining and applying their surface properties. With these tools, you can create color, texture, opacity, and other material characteristics and then apply these characteristics to objects in your model. You can also open the Render Setup dialog box, select the render type, view the last rendered frame, and quickly access the production renderer or the ActiveShade renderer.
The rendering tools give you control over the image output of your 3ds Max scene. Unlike output from most applications, output from 3ds Max 2013 is most likely to be image or animation files or models and resources for exporting to real-time game engines. The rendering tools let you set the type and size of output, from single, large-format stills to video-ready animations.

**Working on a Lower-Resolution System**

If you’re working with a screen resolution less than $1280 \times 1024$, you will not be able to see all the tools on the Main Toolbar. Some of the tools are off the screen to the far right. To access these tools, place the cursor on the toolbar so that a hand icon appears, and then click and drag the toolbar to the left. If you have trouble with this, move your cursor under one of the drop-down lists on the Main Toolbar to access the pan (“hand”) tool. The hidden tools will emerge. You can also click the Rendering menu item to access all the rendering tools. The smallest supported screen resolution for the UI in 3ds Max 2013 is $1024 \times 768$, but the recommended resolution is $1280 \times 1024$ or higher. All the screenshots presented in this book use a $1680 \times 1050$ resolution.

**Docked and Floating Toolbars**

In addition to the Main Toolbar, you may see several floating toolbars sitting on top of the viewport. These toolbars may be hidden by default. You can open hidden toolbars by right-clicking a blank part of any open toolbar. A context menu will appear listing the available toolbars. Let’s take a quick look at the floating toolbars.

1. Right-click a blank area of the Main Toolbar, and click any of the toolbar items that do not have a check mark next to them, as shown in Figure 1.12.
2. Repeat the process until all the floating toolbars are exposed.

All the toolbars float over the viewports and have titles such as Layers, Render Shortcuts, Snaps, Axis Constraints, and Extras. As with most toolbars, you can dock these floating toolbars to the side or hide them altogether to gain better access to objects in the viewports. The toolbars can be resized by clicking and dragging any of their edges.

**Consider a Dual-Screen System**

In 3ds Max and many other graphics programs, screen space is always at a premium. You can use a two-monitor (or even three-monitor) system to help unclutter your primary screen workspace. Simply move items such as floating toolbars, the Material Editor, Curve Editor, Rendered Frame Window, and so forth to the second monitor, freeing up as much screen real estate as possible.

*Layers* are like overlays that help you organize the objects in your model. If you are an AutoCAD or Adobe Photoshop user, you already have an idea of how layers work. You’ll learn more about layers in Chapter 10, “Organizing Objects and Scene Management.” The Layers toolbar is shown in Figure 1.13.

**Figure 1.13**
The Layers toolbar

Render shortcuts contain predefined render settings, such as resolution and output file type, that are used to create content from your 3ds Max scenes. The Render Shortcuts toolbar, shown in Figure 1.14, is where you will find the tools for saving and storing your preset values. You’ll learn about rendering in Chapters 9 through 15.

**Figure 1.14**
The Render Shortcuts toolbar

*Snaps* are features that control where the cursor jumps to, adding a degree of precision to your scene, when the cursor is near a characteristic in the scene. Using snaps, you can easily move the corner of one object to the midpoint of another or nearly any other characteristic combination. The Snaps toolbar is shown in Figure 1.15.

**Figure 1.15**
The Snaps toolbar

Objects are frequently transformed (moved, rotated, or scaled) along a particular axis, or direction, relative to the object or the scene. This functionality is usually utilized through the transform gizmos, onscreen tools used to facilitate the transforms. The Axis Constraints toolbar, shown in Figure 1.16, allows you to control which axis constraints are used in transformations and if constraints are considered when Snaps are enabled.

**Figure 1.16**
The Axis Constraints toolbar
The Extras toolbar (Figure 1.17) contains tools that don’t fit cleanly into other categories. With the AutoGrid button, you can turn on a creation grid relative to the surface of any object in the scene. You can also create an array (numerous, precisely placed clones) of objects in matrices, along a path or at equal intervals.

**Figure 1.17**
The Extras toolbar

Several tools found within 3ds Max utilize a paint brush analogy in their implementation. The location and intensity of the effects are determined by how the brush cursor is dragged over an object’s surface. The Brush Presets toolbar, shown in Figure 1.18, gives you access to the standard brushes and the Brush Preset Manager so that you can modify and save a brush’s parameters. This toolbar is grayed out unless a tool that utilizes it is active.

**Figure 1.18**
The Brush Presets toolbar

The Animation Layers toolbar (Figure 1.19) lets you access tools that control the layering of objects’ animated parameters. Layering allows you to designate which animated features are enabled and which are not, allowing for many possible combinations.

**Figure 1.19**
The Animation Layers toolbar

Large scenes and projects can become very complicated quickly. Containers help you organize assets by combining them into groups. They can be loaded and unloaded at will to reduce the size of files and how much information is active at one time. By refreshing the link to a container, you can help coordinate data and project changes among project teams. By limiting write access to data files, you can protect project scene files. Use container proxies to reduce the size of the file while still seeing the container contents. The Containers toolbar is shown in Figure 1.20.

**Figure 1.20**
The Containers toolbar

Interactions between objects (for example, rigid object collisions, cloth surfaces, ragdolls, and jointed constraints) can be difficult to animate manually. Using MassFX, a dynamics simulation toolset, you can quickly create simulations that account for properties such as gravity, friction, and wind. The MassFX Toolbar is shown in Figure 1.21.

**Figure 1.21**
The MassFX toolbar
The Graphite Modeling Tools, shown in Figure 1.22, are typically docked right under the Main Toolbar, and they provide context-sensitive access to a number of tools and features that enhance the poly-modeling capabilities of 3ds Max.

**Figure 1.22**  
The Graphite Modeling Tools

The Viewport Layouts tabs bar, shown in Figure 1.23, is docked by default to the left edge of the 3ds Max 2013 interface, and it provides access to the standard viewport layouts and allows you to save different viewport layouts in your 3ds Max files to enhance your workflows.

**Figure 1.23**  
The Viewport Layouts tabs bar

You can dock the floating toolbars or float the docked toolbars. Try the following exercise to see how to change the location of toolbars:

1. Click and drag the title bar of the Layers toolbar so that the toolbar is below the Main Toolbar. The Layers toolbar appears ghosted as a horizontal outline just before you release the mouse button.

2. When the outline is in the position shown in Figure 1.24, release the mouse button. The Layers toolbar is now in a docked position.

**Figure 1.24**  
Docking the Layers toolbar under the Main Toolbar

3. Click and drag the Extras toolbar, and dock it just to the right of the Layers toolbar (also just under the Main Toolbar), as shown in Figure 1.25.

**Figure 1.25**  
Docking the Extras toolbar
4. Right-click the two vertical lines (called the **toolbar handle**) on the left side of the Extras toolbar to open the context menu shown in Figure 1.26.

**Figure 1.26**
Floating the toolbar

5. Select **Float** from the context menu. The Extras toolbar returns to its floating position. Other ways to float a toolbar include dragging the toolbar by its handle down into the viewport or double-clicking the handle.

6. Toolbars can be docked on any side of the viewports. However, you should avoid docking toolbars to the left and right sides of the interface if the toolbars have drop-down lists; otherwise, the lists will not appear. Select the Axis Constraints toolbar, and dock it to the left side of the user interface (Figure 1.27).

**Figure 1.27**
Toolbar docked left

7. Select the remaining floating toolbars, and dock them on the top, right, or left edge of the viewport.
In this brief exercise, you learned how to dock and float toolbars and how to access the context menu where you can toggle the toolbars on and off. Most of the toolbars aren’t required in the early chapters of this book, and they occupy a portion of available screen space. You can hide or float the toolbars however you like.

**Toolbar Flyouts**

You may have noticed that some of the tools in the Main Toolbar show a small triangle in the lower-right corner of the tool’s icon (see Figure 1.28).

**Figure 1.28**

Flyout arrow

That arrow indicates that the tool is one of several offered in a flyout. A flyout is like a graphical version of options in a menu bar. If you click and hold a tool that’s part of a flyout, you see a set of additional, similar tools appear. For example, if you click and hold the Select And Uniform Scale tool, two additional tools appear, as shown in Figure 1.29.

**Figure 1.29**

The Select And Uniform Scale flyout menu

Once you select an option from a flyout, it becomes the default button that you see in the toolbar.

**The Viewports**

At the center of the window are the viewports (see Figure 1.30). You’ll be doing most of your modeling work in a viewport. In a blank file, the viewports show a grid that you can use as a reference for orientation and size.

**Figure 1.30**

A typical viewport configuration
If you look in the lower-left corner of the viewport, you will see the World Axis Tripod that indicates the orientation of the X-, Y-, and Z-axis. The World Axis Tripod helps you get your bearings when you are looking at camera and perspective views.

Currently, there are four viewports named Top, Left, Front, and Perspective, as indicated by the labels in the upper-left corner of each viewport. You can also tell that the Perspective viewport is different from the others by the way the grid squares get smaller and converge in the distance, and it has a gradient background. As you’ll see toward the end of this chapter, you can configure and view your model in a variety of ways, depending on your needs.

**Tools for Working with the Viewports**

At the bottom of the window are several other options that are grouped into six sections the status bar, the prompt line, the time controls, the time slider, the track bar, and the viewport navigation tools (see Figure 1.31). Most of these tools affect the viewport, either by modifying the display of the viewport directly or by affecting the way you interact with objects within the viewport.

**FIGURE 1.31**
The bottom sections of the 3ds Max 2013 window

The viewport navigation tools give you control over the main graphic display in the center of the window. With these tools, you can zoom and pan over the display as well as alter the viewpoint of your model. You can also switch between multiple views and a single view. Try the following:

1. Right-click in the Perspective viewport to make it the active viewport, and note that it is now surrounded with a gold border; then click the Maximize Viewport toggle in the far lower-right corner of the window. This is a tool you’ll be using often. You can also press Alt+W on the keyboard.

   The graphic display changes to display a single viewport showing only the viewport that had the gold border, the Perspective viewport in this case.

2. Click the Maximize Viewport toggle to divide the viewport area into four individual viewports again.

3. Click the upper-right viewport, labeled Front. Notice that the border of the Front viewport becomes highlighted in yellow.

4. Click the Maximize Viewport toggle again. Now the Front viewport fills the graphic area. Notice how you can quickly expand the view of a viewport to see more detail.

5. Click the Maximize Viewport toggle again to return to a four-viewport layout.
6. Place your cursor at the intersection of the four viewports until it changes to a crossed-arrows cursor. Click and drag to resize all viewports simultaneously, as shown in Figure 1.32. You can also place the cursor between just two viewports to resize the viewports in only one direction.

**Figure 1.32**
Resize the viewports by dragging their intersection.

7. Right-click the border between two viewports, and choose Reset Layout from the context menu to return to the default layout, as shown in Figure 1.33.

**Figure 1.33**
Reset Layout option

You’ve just seen how you can display a single viewport or expand the graphic area into multiple viewports showing the Top, Front, Left, and Perspective viewports. Several other views and viewport arrangements are available, as you’ll see later in this chapter.

**Using Shortcut Keys to Switch Viewports**

You can set the current, active viewport to display a top, front, or left side view by pressing the T, F, or L key. You can also press B for the bottom view. Pressing P will display the perspective view, and pressing U will display an orthographic user-defined view. If you have added a camera, you can press C to select from a list of camera views. The hotkeys of R for right view and K for back have been changed from the defaults in previous versions of 3ds Max and now are used for cycling Scale options and Set Keys respectively. You can easily assign your own hotkeys to commands.
To the left of the viewport navigation tools are time controls. These tools give you control over the animation functions of 3ds Max. Here you can set your creations in motion by selecting the length of time for your animation as well as set the precise location of objects within that time frame.

Near the bottom center of the interface is a large button with the symbol of a key on it and two smaller buttons to the right that are used to create animation keyframes, called *keys*, as shown in Figure 1.34.

**Figure 1.34**
The animation and time controls

The long horizontal elements across the bottom of the viewport are the time slider and track bar, which are used for animation. You can hide the track bar to save space on the screen. Choose Customize ➤ Show UI ➤ Show Track Bar to toggle this part of the interface off until you’re ready to make animations. For the exercises in this book, leave the track bar visible.

Just to the left of the animation controls are the transform type-ins, shown in Figure 1.35. This area displays the location of your cursor in X, Y, and Z coordinates. It also displays other types of data, depending on your current activity. For example, if you’re rotating an object, the coordinate readout displays the rotation angle of the object being rotated. If you’re scaling the data, these text boxes will show percentages.

**Figure 1.35**
The transform type-in

In addition to the transform type-ins, there is a Grid panel, shown in Figure 1.36, which may be hidden to the right if your display is set to low resolution. To find it, if necessary, place the cursor on the vertical bar just to the left of the prompt line until you see a double-pointed arrow.

**Figure 1.36**
The Grid panel

When you see the arrow, click and drag to the left. The Grid panel will be revealed to the right of the transform type-ins.

The Grid panel displays the default setting for the grid size in the current scene. You can hide or display a grid in the active viewport by pressing the G shortcut key. Right-click the Snaps toggle, Angle Snap toggle, or Percent Snap toggle in the Main Toolbar, and then click the Home Grid tab of the Grid And Snap Settings dialog box to set the grid spacing and other grid parameters, as shown in Figure 1.37.

**Figure 1.37**
Grid and Snap Settings
Finally, to the far left at the bottom of the 3ds Max window is the MAXScript Mini Listener, as shown in Figure 1.38. MAXScript is a programming language that allows you to create custom applications or macros in 3ds Max. A macro contains a prerecorded series of instructions. The MAXScript Mini Listener serves two functions the pink area displays your activity when the MAXScript MacroRecord function is turned on, and the white area provides a space where you can enter commands using the keyboard.

**Figure 1.38**
The MAXScript Mini Listener

---

**Getting to Know the Command Panel**

You’ll be using the Command panel for most of your work in 3ds Max. If you’re an experienced AutoCAD user, you might think of the Command panel as the equivalent of the AutoCAD command line; it’s a single entry point for most of the program’s functions. The Command panel offers nearly all the tools for creating and editing in 3ds Max.

Across the top of the Command panel, you’ll see a set of six tabs, each displaying an icon, as shown in Figure 1.39.

**Figure 1.39**
The tabs at the top of the Command panel

From left to right, the tabs are Create, Modify, Hierarchy, Motion, Display, and Utilities. If you place your cursor on a tab, you’ll see a tooltip displaying the name of the tab. When you click a tab, the functions relating to the tab appear in the rest of the Command panel. Here’s a brief rundown of what each tab offers:

**Create**  This tab allows you to create two- and three-dimensional objects. You can also create light sources, cameras, and helper objects that are used to determine distance and relationships between objects. Light sources, cameras, and helpers are objects that don’t appear when your view is rendered.

**Modify**  This tab gives you control over the dimension, shape, and parameters of your objects. On it, you’ll find tools to extrude, twist, and bend your objects. You can also control methods for applying material definitions to objects (called mapping coordinates) on this tab.

**Hierarchy**  This tab offers a set of tools aimed primarily at animation. The options on this tab let you build relationships between objects to simulate joint movement or to constrain the motion of one object in relation to another. It also offers a way to control the location of an object’s pivot point.

**Motion**  This tab also gives you control over animation. Here you can control the actual motion or parameter change of objects over time and view the objects’ trajectories.

**Display**  This tab lets you turn the visibility of objects on or off in your model. There may be times when you don’t want a particular object visible while you render your model or while
you’re editing a complex model full of objects. Display lets you temporarily hide objects from view or lock them out from being selected. Objects can be hidden individually or by category.

**Utilities**  This is a kind of catchall tab that provides access to special features and plug-ins. Here you find the Camera Match utility, which lets you match your model view to a photograph. You can also get access to the MAXScript customization features on this tab.

---

### Floating and Hiding the Command Panel

You can move the Command panel just like any other toolbar, or you can close the panel entirely by clicking the Close button (the one with the X, in the upper-right corner of the window) when the panel is floating. To bring the Command panel back, right-click the blank area of any toolbar and then select Command Panel from the context menu. You can also right-click the Command panel's title bar to dock the panel on the left or right side of the screen or minimize the Command panel to autohide it when it’s not in use.

---

### Understanding the 3ds Max Tools

A few ways of working in 3ds Max are a bit unusual for a Windows program. In this section, you’ll explore the Create tab of the Command panel as a way to understand some of the quirks of 3ds Max. There aren’t many, but understanding them now will make it easier for you to learn how to use the program.

### Getting to Know Scrolling Panels and Rollouts

3ds Max 2013 has a rich set of creation and editing tools — so many, in fact, that 3ds Max’s programmers had to come up with a way to get to them easily without making the program too arcane. Two of these tools help you navigate its interface: the scrolling panel and the rollout. A **scrolling panel** is an area that can be scrolled up or down using a pan cursor. A **rollout** is a set of tools that can be opened or closed, much like a drawer in a dresser. Let’s start by looking at how a scrolling panel works:

1. Click the Create tab of the Command panel. Notice the row of icons just below the title of the tab, as shown in Figure 1.40. These icons are buttons, or tools, that offer different categories of objects.

**Figure 1.40**
The categories under the Create tab

2. Place the cursor over the tool that looks like a movie camera. Notice that a tooltip displays, offering the name of the tool.

3. Click the Cameras tool. You see the options change below the tools, as shown in Figure 1.41.
4. Click the Target button. A set of additional options appears. Although it may not be obvious, these options extend beyond the bottom of the Command panel.

5. Move your cursor down to a blank spot in the Command panel. The cursor changes to a hand.

6. Click and drag upward with your mouse. Notice that the options in the Command panel scroll up, following the motion of your mouse. This is an example of a scrolling panel. This scrolling action exposes the rest of the options in the lower portion of the Command panel. Release the mouse button at any time once you’ve seen how this scrolling action works.

7. Place your cursor on a blank area again so that the pan cursor displays. Then click and drag down to view the Target and Free buttons under the Object Type bar.

8. You can also scroll the Command panel by dragging the dark-gray slender vertical scroll bar on the right side of the Command panel, as shown in Figure 1.42. Try both of these methods.

9. Another way to see more of the Command panel is to increase its width by dragging the vertical border between the Command panel and the viewport. Position your cursor along this edge, drag to the left, and expand the Command panel to two and then three columns.

10. The advantage to having a two- or three-column Command panel is obvious — you can see all the controls within the Command panel at once. The disadvantage is equally
apparent — the viewport area becomes much smaller. Drag the Command panel back to one vertical column to give yourself the maximum amount of screen space. In a one-monitor system, it’s better to scroll within the Command panel than to sacrifice valuable viewport space.

11. Hover the mouse near the top of the Command panel, and you will see the cursor change. Then right-click and choose Minimize. The Command panel is reduced to a single, narrow border tab. Move your cursor over it to reveal it; move it off it to autohide. This works really well if you have a two- or three-column format.

In this exercise, you learned that you can change the entire set of options by clicking a single tool. You can also see that the set of tools can extend beyond the bottom of the Command panel. You can scroll the options up or down within the panel in several ways. This allows 3ds Max to offer a wide variety of options within the limited space of your display.

The Main Toolbar also acts like a scrolling panel whenever a portion of the toolbar extends beyond the screen area. For example, if your screen resolution is $1024 \times 768$, a portion of the Main Toolbar isn’t visible to the right of the screen. If you place the cursor on a blank area of the Main Toolbar, it turns into the pan cursor. You can then click and drag to the left to display the additional tools.

When you clicked the Target button in step 4 of the preceding exercise, a set of options appeared under a bar labeled Parameters. There are three other bars, labeled Depth Of Field Parameters, Object Type, and Name And Color. Notice the minus (−) sign to the far left of these bars. These bars display the titles of the rollouts. They let you open and close a set of options to get them out of the way or to roll them out for use. Try the following:

1. Click the rollout labeled Parameters. The options below the Parameters rollout disappear. Also notice that the minus (−) sign to the left of the rollout changes to a plus (+) sign. This indicates that the rollout is in its closed state. The plus tells you that there is more information inside, waiting to be rolled out.

2. Click the rollout labeled Name And Color. It also closes and displays a plus (+) sign to the left. Click the rollout to open it again. Right-click a blank part of the interface within any one of the rollouts, and you’ll see a context menu (Figure 1.43). Select Close All.

**Figure 1.43**
Select Close All to close open rollouts in a panel

3. Notice that the Parameters and Depth Of Field Parameters rollouts closed but Object Type and Name And Color remained open. This is because all objects on the Create Panel have Object Type and Name And Color rollouts, and these always remain open by default. Any additional rollouts belong to the object you have chosen to create and can be controlled with this context menu. Try dragging the Depth Of Field Parameters rollout above the Parameters rollout, as shown in Figure 1.44.
You will see a horizontal blue bar appear with an image of the rollout you are dragging ghosted. When you release the mouse, the rollout you are dragging gets docked where the blue bar used to be. Now the Depth Of Field Parameters rollout should appear above the Parameters rollout, as shown in Figure 1.45.

5. Click the Parameters and Depth Of Field Parameters rollouts again to display the options.

Now you can see how easy it is to control and customize the Command panel interface. In this and later chapters, you’ll explore the rollouts that appear in the Command panel.

**Creating Objects and Setting Their Parameters**

By now, you’ve seen most of the 3ds Max interface and how it functions. However, you should know about a few more tools and methods before you delve into using 3ds Max. In the following exercises, you’ll get a chance to create a simple object and, in the process, you’ll be introduced to a few new tools.

1. On the Create tab of the Command panel, click the Geometry tool at the top of the panel, as shown in Figure 1.46. Make sure that Standard Primitives appears in the drop-down menu, and you will see the Object Type rollout with a set of object types.
2. Click the Box button. Additional rollouts appear in the Command panel. They include Creation Method, Keyboard Entry, and Parameters. Notice that a message in the prompt line at the bottom of the screen says, “Click and drag to begin creation process.” Also, the cursor in the graphic area displays as a cross, telling you that you’re in Object Creation mode.

3. In the Perspective viewport, place the cursor at the center of the graphic area at coordinates 0,0, where the two darker grid lines intersect, and click and drag diagonally to the upper-right corner of the screen — don’t release the mouse button just yet. As you move the mouse, a rectangle follows your cursor. Notice that the values in the Length and Width input boxes in the Parameters rollout change as you move the mouse.

4. Place the cursor so that the rectangle looks similar to the one shown in Figure 1.47, and then release the mouse button. (You don’t need to match the rectangle in the figure exactly.) Now, as you move the cursor, the rectangle changes in height. Notice that the Height value in the Parameters rollout also follows the change in height.

5. Adjust the height so that the Height parameter shows about 3’ 0”, and left-click your mouse. The box is now fixed at the height you selected. It should look similar to Figure 1.48.

**Figure 1.47**
The box object so far

---

**CREATE A NEW BOX IF NECESSARY**

The following steps work as directed only if you have not deselected the box. If you have, click the Undo Scene Operation button in the Quick Access Toolbar until the box disappears, create a new box, and then proceed with the following steps.

You’ve just created your first object in 3ds Max and, in the process, you’ve seen how the dimensions of an object are reflected in the Parameters rollout. Once you’ve created an object, you can continue to modify its parameters, as the following exercise demonstrates.
In the Parameters rollout, locate the Width input box and click the up arrow to the right of the box several times. Arrows like this one are called spinners, and they allow you to adjust graphically the value of the associated input box. Notice that the box in the Perspective viewport begins to widen as the value in the Width input box increases, as shown in Figure 1.49.

1. Click and hold down the left mouse button while pointing to the up arrow of the Width spinner. Notice that the box continues to grow in width as you hold down the mouse button. When you hold down the mouse button and move the mouse forward or backward, the rate of change on the values accelerates.

2. Right-click the spinner arrow. The box shrinks in width to 0'0". Right-clicking any spinner changes the spinner value to its lowest possible non-negative value, which is 0'0" in this case.

3. Click the Width spinner, and drag the mouse up. The box grows wider. Click and drag down, and the width decreases.
5. Click and drag the Width spinner up until your cursor reaches the top of the screen. Then continue moving the mouse up the screen, and notice that the cursor reappears at the bottom of the screen and continues moving up the screen. This *circular* action of the spinner lets you scroll continuously without being limited by the screen area.

### UNDOING SPINNER CHANGES

While adjusting a spinner, you can immediately undo any changes you make by right-clicking the mouse while still holding the left mouse button. This allows you to experiment with spinner settings quickly while you work.

You’ve just seen how you can change the parameters of an object by using the spinner. Now let’s take a look at the absolute way of entering values into input boxes:

1. Double-click the Length input box in the Parameters rollout and type `60 ø`. Notice how the box’s length changes and the Length value changes to `5’0.0”`, the feet and inches equivalent of `60”`.

   Notice that it’s not necessary to enter the inch (”’) symbol to indicate a measurement in inches. You are, however, required to enter the foot (´) symbol when entering a measurement in feet. This is because you selected the Inches option as the default units in the Units Setup dialog box earlier in the chapter.

2. Press the Tab key. Notice that the Width value is now highlighted, as shown in Figure 1.50.

   ![Figure 1.50](image)

   Press the Tab key to jump to the next value

3. Type `60` for the width, and press Tab again. The Height value is highlighted.

4. This time enter `5’0”`. The box is now a cube `60”` square.

### USING THE CUBE CREATION METHOD

You can also create a cube directly by selecting the Cube radio button in the Creation Method rollout.

### USING THE TAB KEY

If there is a series of related input boxes — such as the Length, Width, and Height boxes in the previous exercise — the Tab key lets you advance from one field to the next. You’ll find that numeric input boxes and spinners are quite common throughout 3ds Max.
Setting the Spinner Rate of Change

If you hold down the Ctrl key while you move a spinner, the rate of change in the spinner value increases. The Alt key has the opposite effect, decreasing the rate of change. The higher the numeric value in the spinner, the faster the rate of change and vice versa.

Working with Objects

Now that you’ve seen the main elements of the 3ds Max interface, we’ll cover how you interact with objects in the viewport. You’ll start by looking at a way to move the box you’ve just created. Then you’ll learn how you can view your box from different angles.

Selecting and Moving Objects

The basic editing tools of 3ds Max are simple and straightforward, although it may take a little explaining for you to grasp the finer points. As with most graphics programs, you use a selection tool to select objects. The Select tool is typically shown on the toolbar as an up arrow that looks like the standard Windows cursor floating over a cube.

1. Click the Select Object tool in the Main Toolbar.
2. Click a blank area of the viewport. This clears any selections that may currently be active.
3. Move the cursor over the box. Notice that the cursor turns into a plus (+) sign. This tells you that the cursor has found a selectable object.
4. Click the box to select it. A graphic displays, showing the X, Y, and Z orientation of the box in relation to the viewport (see Figure 1.51). Also notice that in the Perspective view, marks like 3D corner marks appear at the corners of the box. These are called selection brackets, and they graphically indicate the objects that are selected.

Figure 1.51
The selected box

With the box selected, you can go to the Modify tab of the Command panel and edit its properties, or you can use any number of other editing tools to affect the box.

Let’s continue by looking at one of the more basic editing tools you’ll use — the Select And Move tool.
1. Click the Select And Move tool in the Main Toolbar. Notice that the graphics indicating the box selection change and new ones appear.

2. Place the cursor on the box. It changes into the Select And Move icon.

3. Click the box if it isn’t still selected. A manipulator known as the Move transform gizmo appears, showing the X, Y, and Z orientation of the box in relation to the viewport. Selection brackets also appear at the corners of the box.

4. Place the cursor on the blue Z-axis handle of the Move transform gizmo; the blue arrow represents the Z-axis. Notice that the Z-axis and axis label highlight in yellow and the X-axis and axis label turn back to red. When you move the cursor away from the Z-axis, the X-axis is highlighted again and the Z-axis returns to blue. The yellow highlighting shows you which axis is currently active. The X-axis is the default constraint direction. If the Axis Constraints toolbar is still open, you’ll see that the X-axis button is selected. As you’ve seen in this step, you can select an axis to constrain just by placing your cursor on the axis coordinate arrow.

5. Place the cursor on the XY-plane handle, the square that joins the X and Y handles of the Move gizmo. Notice that the XY-plane handle highlights in yellow (see Figure 1.52). Click and drag the box on the grid. The box now moves in the XY-plane. When you click and drag the X arrow, movement is constrained along the X-axis only.

6. Click and drag the blue Z-axis handle upward. Now movement is constrained in the Z-axis, away from and toward the grid. As you may guess, clicking and dragging the green Y-axis handle constrains movement along the Y-axis.

**Figure 1.52**
Moving the box in the XY-plane

---

**The Last Axis Transformed Is Highlighted in Yellow**

The axis that is highlighted in yellow is the last axis constraint that was used. For example, if you transform an object in the Y direction, the next time you start to transform an object, the Y-axis will be highlighted.
If you click an object in a location other than the coordinate arrows, you can freely move the object in the current axis or plane restriction. Notice that the coordinate location of the object is displayed in the status line.

**CONSTRaining Motion**

The tools in the Axis Constraints toolbar constrain the motion of an object in the X-, Y-, or Z-axis. For example, to constrain motion in the X-axis, click the Select And Move tool, and then click the X in the Constraints toolbar. The selected object’s motion is constrained to the X-axis. In early versions of 3ds Max, this was the only method available to constrain motion.

Another important function that the Axis Constraints toolbar offers is the selection of the default free motion plane. In step 5 of the preceding exercise, you were able to move the box freely in the XY-plane, but you were constrained to that plane. The Axis Constraints toolbar lets you select the default plane to which you are constrained. The Restrict To XY-Plane tool is a flyout offering three options: XY, YZ, and ZX. You can select the plane in which you want to constrain motion by selecting one of these three options. The XY option is fine for nearly all of your work; every now and then, though, you’ll want to use one of the other options, so it’s good to be aware of this tool. You can also access these constraint planes simply by dragging the appropriate parts of the transform gizmo — it’s very intuitive.

If you prefer to use shortcut keys instead of a toolbar, the F5, F6, and F7 keys toggle the Y-, Y-, and Z-axis constraints, respectively. Pressing the F8 key repeatedly cycles through the XY-, YZ-, and XZ-plane constraints.

Finally, a tool that is related to the transform tools is the Selection Lock Toggle tool.

Any objects that are selected when this tool is clicked will remain selected as long as the Selection Lock Toggle is toggled to the On position. This tool helps prevent the accidental loss of a selection due to a mouse click. It also allows you to use the transform tools without actually placing the cursor on the selected objects. You can also toggle this tool on and off by clicking it or by pressing the spacebar while in a selection mode.

As you see, moving an object in 3ds Max is fairly straightforward. But what if you want to move an object a specific distance or to a known position? The following exercise demonstrates how this is done:

1. With the box still selected and the Select And Move tool still active, click the Absolute Mode Transform Type-In button at the bottom of the 3ds Max window, as shown in Figure 1.53. The tool changes to show that the Offset mode is active.

**Figure 1.53**

Absolute Mode Transform Type-In (top); Offset mode (bottom)
When the Absolute/Offset Mode Transform Type-In button is in the Absolute mode (up),
you can enter the specific coordinates of the point where you want to move your object.
When it’s in the Offset mode (down), you can enter a relative distance from the object’s
current location.

2. Click in the X input box in the coordinate readout and type 10. The box moves 10 inches
   in the positive X direction.

3. Click and drag the Z-coordinate readout spinner upward. The box moves vertically.

4. Click the Absolute/Offset Mode Transform Type-In button to switch to Absolute mode.
   Then click in the Z-coordinate readout input box and enter 1'. The box moves so that its
   base is exactly at 1' for the Z-coordinate.

5. Right-click the X-coordinate readout spinner. Remember that right-clicking a spinner con-
   verts the value associated with the spinner to its lowest value, which is 0'0.0" in this case.
   Notice that the box moves to 0 for the X-coordinate.

6. Right-click the spinners for the Y- and Z-coordinates in the coordinate readout. The box
   moves to the center of the screen at the origin (coordinates 0,0,0), as shown in Figure 1.54.

**Figure 1.54**
Moving the box to
the origin

Just as with the spinners in the Command panel, the Coordinate Display spinners let you
set values by clicking and dragging. You can also return to the default values of zero by right-
 clicking the spinners. When in Offset mode, the spinners automatically reset to zero because the
values represent numerical values away from the current, baseline location. The spinners in the
coordinate readout appear when you turn on the Select And Move, Select And Rotate, or Select
And Scale tool from the Main Toolbar.
ACCESSING THE TRANSFORM TYPE-IN DIALOG BOXES

If you are accustomed to earlier versions of 3ds Max, you can still use the floating Transform Type-In dialog boxes that appear when you right-click the Select And Move, Select And Rotate, and Select And Scale tools. Most recently, this functionality has been added to the quad menu; by clicking the Settings button to the right of Move, Rotate, or Scale, you are taken to the appropriate Transform Type-In dialog box automatically. You can also access the Transform Type-In dialog box by using the F12 key.

Rotating and Scaling Objects

Besides the Move tool, the transform tools also include the Rotate and Scale tools. Try the following set of exercises to see how these tools work.

1. With the box selected, click the Select And Rotate tool in the Main Toolbar. The Rotate transform gizmo, a kind of virtual trackball, appears with rings representing the rotation about the X-, Y-, and Z-axes.

2. Place your cursor on the red ring that circumscribes the X-axis. Notice that the ring is highlighted in yellow. Click and drag the X-axis ring upward. The box rotates about the X-axis, as shown in Figure 1.55. A tangent indicator arrow will appear, indicating the direction of rotation. A transparent red slice along with a text tooltip also appears, displaying the amount of rotation. Release the mouse button to set the rotation angle.

Make sure that the Absolute/Offset Mode Transform Type-In button is in the Absolute mode and look at the coordinate readout. Notice that the X value is not zero, because you rotated it in step 2. It now shows a number of degrees.

3. Right-click the X spinner in the coordinate readout to set the X value rotation back to zero. Notice that the box snaps back to its original orientation.
The Select And Rotate tool’s methods are the same as the Select And Move tool’s methods. You can rotate an object graphically by clicking and dragging the object or, with an object selected, you can enter an exact rotation value in the coordinate readout. When the Absolute/Offset Mode Transform Type-In button is in the Absolute mode, you can control the orientation in relation to the object’s original orientation when it was created. In the Offset mode, you can control the orientation relative to the object’s current orientation.

Now try the Select And Uniform Scale tool:

1. With the box selected, click the Select And Uniform Scale tool in the Main Toolbar. The Scale transform gizmo appears, showing the X, Y, and Z orientation of the box in relation to the viewport.

2. Click in the center of the Scale gizmo that appears, or on the box itself, and drag upward. The box grows uniformly in size.

3. Click and hold the Select And Uniform Scale tool. Then, from the flyout, select the middle tool, which is the Select And Non-uniform Scale tool, as shown in Figure 1.56. This step is not absolutely required; it is presented here to clarify the concept. The axis handles alone can be used to scale an object non-uniformly.

4. Drag the XY-plane handle of the Scale gizmo (highlighted in yellow onscreen) to scale the box non-uniformly in the XY-plane in this case, but not along the Z-axis. Similarly, the axis handles can be dragged individually to constrain the scaling of an object to one axis (Figure 1.57).
Now take a look at the coordinate readout. The values you see are percentages of scale. When the Absolute/Offset Mode Transform Type-In button is in the Absolute position (up), the values are percentages of the original size of the object. When it’s in the Offset position (down), the values are the scale in relation to the current size and are immediately reset to 100 percent when you release the mouse button.

1. With the Absolute/Offset Mode Transform Type-In tool in the Absolute position, click and drag the Z spinner up. Notice that the box grows in the Z-axis.
2. Right-click the Y-axis spinner. The box distorts to a 0 value in the Y-axis.
3. Click in the X-value input box, and enter 100 ø. The box’s X value is restored to its original size.

**How 3ds Max Sees the Scale Transform**

Look at the box’s Length, Width, and Height values in the Parameters rollout in the Command panel. If the Parameters rollout for Box001 does not display, you have to click the Modify tab. The values all read 5 ø 0.0” even though the box has been scaled. This is an important indicator as to how 3ds Max handles object data. For example, if you have a box that is 1 unit long on each side and then you scale it to twice its size, 3ds Max does not now see this as a box that is 2 units on each side; it sees it as a 1-unit box with a 200 percent scale factor applied.

4. Press the Tab key to move to the Y-value input box and enter 100 ø.
5. Press Tab again to move to the Z-value box and enter 75 ø. The box is now slightly shorter than it is wide and long.

The Select And Scale tool works in a slightly different way from the other two transform tools. For one thing, a zero value in the coordinate readout doesn’t return the selected object to its original shape. This is because the values in the coordinate readout represent percentages, where 100 percent is the object’s original size.

The Scale gizmo allows you both to uniformly and non-uniformly scale an object by automatically switching between scale modes. Which operation you perform depends on which part of the Scale gizmo you drag.

1. Try dragging the center of the Scale gizmo. You will see the object get uniformly bigger or smaller when you drag upward or downward.
2. This time, put your cursor over one of the edges of the Scale gizmo. When you drag over one of the plane handles, you are performing a non-uniform scale in two directions at once. Look closely at the gizmo, and you can see that the two axes of the plane are highlighted. Try non-uniformly scaling the box in the YZ plane (see Figure 1.58a).
3. The last operation you can perform using the Scale transform gizmo is a non-uniform scale in one direction. To accomplish this, put your mouse directly over the axis handle at the tip of an axis. For example, put your mouse over the end of the Y-axis and drag to scale in that direction only, as shown in Figure 1.58b.

Once you master the mechanics of the transform gizmos, you will find that you have much finer and more intuitive control over your objects in 3ds Max.
CHAPTER 1
GETTING TO KNOW AUTODESK® 3DS MAX® 2013

**Figure 1.58**
Using the Uniform Scale transform gizmo, in two axes on the box (a), and along one axis, on the box (b)

(a) (b)

**Copying an Object**
We've covered just about all the ways of moving, rotating, and scaling an object in the Perspective viewport. If you want to copy an object, use the same methods you would to move, rotate, or scale objects — with the addition of holding down the Shift key. Try the following steps to see how copying, or cloning, as it's called in 3ds Max, works. (Copying is one of the forms of a more general function called cloning.)

1. From the Application menu, choose Open and click No in the dialog box that opens asking whether you want to save the changes in your current file. The Open File dialog box appears. Navigate to the Chapter 1 files you downloaded from the book's accompanying web page, www.sybex.com/go/mastering3dsmax2013. Select the Chair.max file, and then click the Open button.

2. Click the Select Object button in the Main toolbar, and then select the chair.

3. Click the Select And Move button.

4. While holding down the Shift key, move the cursor over the XY-plane of the transform gizmo, and then drag the chair to the left. A second chair appears.

5. Release the mouse button. The Clone Options dialog box displays (see Figure 1.59). This dialog box lets you control the quantity and type of copies you're making as well as the name of the new objects.

6. In the Object group of the Clone Options dialog box, select Copy.

7. Click OK. The new chair is added to your model, as shown in Figure 1.60.
Create a Copy in the Same Location as the Original

You may want to make a copy of an object in exactly the same location as the original object. To accomplish this, first select the object you want to copy and then select Edit > Clone from the Menu Bar or press Ctrl+V on the keyboard. You will see a Clone Options dialog box similar to the one that you saw in the preceding exercise. Set your options and click OK. Note that the new copy doesn’t appear at first because it occupies the same space as the original. (You can accomplish the same thing by Shift+clicking an object with the Select And Move tool or by selecting Clone from the Transform quad menu, which can be accessed by right-clicking the object.)

**Figure 1.60**
The original and cloned chairs

In step 6, you selected the Copy option in the Clone Options dialog box. This option creates a distinct copy of the original object. The other two options, Instance and Reference, create clones that are related to the original in such a way that changes in one object affect the other. You’ll learn more about these options in Chapter 2, “Introducing Objects.”

Parking Curbs and Bollards

Jon McFarland, one of the authors of this book’s 2010 edition and the technical editor on this edition, says that every project has features in it that vary from interesting and cool to mundane and repetitive. Although we all like to work on the exciting projects, we all do our share of the latter. When those less-than-exciting projects pop up, it’s best to crank them out quickly and accurately and then move on to the next portfolio-quality project down the line.

While the main effort of McFarland’s company was focused on the creation of a mall, complete with an entertainment center and several freestanding buildings for restaurants and other shops, someone had to work on the parking lot. He was hired to place several thousand parking curbs and bollards (vertical posts used to restrict vehicular traffic) accurately throughout the parking lot and around the entrances to the structure. Parking curbs are usually identical and placed equidistant from each other (usually 9’ 0” apart), so the layout wasn’t difficult. After modeling the simple curb, he placed one at the end of each parallel run of parking spaces. He selected the first curb on each run, held down the Shift key, and moved it 9’ in the proper direction. In the Clone Options dialog box, he set Number Of Copies to the number of curbs in the longest run and then deleted any superfluous curbs.